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3 An example ANSI C interactive debugging session

Figure 3.8 Source code before line 49 has been selected

Step 10. Select line 49 by clicking somewhere on the 'send_data' function call. The
selection line marker, ~ on Suns or <> on PCs, appears alongside the state­
ment. Click on the blank space after the statement to ensure that no text is
highlighted, or else clicking on Break will cause the debugger will try to set a
breakpoint on a function of that name.

Step 11. Click on the Break button to set a breakpoint at the selected line. A breakpoint
marker, 0 on Suns or~ on pes, appears alongside the selected line marker.
Notice that the output window displays a message telling you about the break­
point you have just set:

breakpoint 1 at <facs.c 49 0> iptr #8000fbdf of facs •••

This means the breakpoint has been labelled event number 1. It has been set
at the start of line 49 of the file facs. c. The part in chevrons, '<facs. c 49
0>', means the zeroth step of line 49 of the file facs .c. The breakpoint has
been set in the code at address #8000fbdf.

If you scroll the output window up one line, you will find:

2 1 > break <facs.c 49 0>

This means that a breakpoint has been set in process 2, thread 1. The break­
point applies only to the currently selected thread, main, and will cause execu­
tion of the thread to stop when this line is about to be executed. If there were
other threads using the same code they would not be affected by this break­
point.

A breakpoint set at process level would act on all the threads in the currently
selected process. It would give a message like:

1 0 > break <facs.c 49 0>
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3.3 Step-by-step tutorial

The'l 0 >' means all threads of process 1.

Figure 3.9 Source code after the breakpoint has been set
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3 An example ANSI C interactive debugging session

3.3.3 Starting the example program

Step 12. Having set a breakpoint you are now ready to start the example program. If you
were to click on the Continue button at this level you would only start thread
main of the facs process running. To ensure that all the processes are set
running you must use the browser to return to the program level. To do this,
move the cursor to the browser window and click on the Processes button to
display the list of processes. The browser returns to program level and the
browser window changes to look like figure 3.10.

Figure 3.10 Browser window showing the example program's processes

Step 13. At this level, with no processes selected, you can start all the processes by
clicking on the Continue button. When you do, notice that the output window
displays the message:

o 0 > continue

The '0 0 > I means all threads of all processes.

Step 14. As the app program runs it displays the following message in the program
window:

Sum of the first n (n < 9) squares of factorials
Please type n :

Move the cursor to the program window and type '4' followed by a return.

Step 15. The output window should now display the message:

2 1 facs main : breakpoint 1 at <facs.c 49 0>

This tells you that breakpoint 1 has been hit in thread main of process facs.
This should come as no surprise as it is where you set the breakpoint in Step
11.
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3.3 Step-by-step tutorial

3.3.4 Locating where a breakpoint has occurred

Step 16. To display the code where the breakpoint has occurred, click on the Last Event
button. The context changes to frame level at the last breakpoint or watchpoint
that occurred.

Figure 3.11 Browser window after the breakpoint has been located

Figure 3.12 Code window after the breakpoint has been located
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3 An example ANSI C interactive debugging session

3.3.5 Removing a breakpoint

Step 17. The breakpoint has served its purpose, so you can now delete it.

With the selection line marker, $ on Suns or <> on pes, on line 49, click on the
Delete button. The breakpoint marker disappears. The output window should
display:

2 1 > delete <facs.c 49>;

which means that the breakpoint on line 49 of facs • c has been deleted.

3.3.6 Examining a variable

Step 18. You are now going to examine the value of a variable.

Place the cursor on the variable 'n' on line 49, and highlight it by double clicking
the left mouse button. This causes the whole word to be selected, which in this
case is just the letter n.

Step 19. Display the value of the variable by clicking on the Print button. The Print
operation displays the value in the output window; it does not produce a hard
copy. The output window should show the message:

1

This tells you that the factorial function is about to compute the factorial
of 1.
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3.3 Step-by-step tutorial

3.3.7 Single stepping through the source code

Step 20. Since this thread is stopped you can step through the code and follow the
execution path. Line 49, the current location, has a call to the factorial
function.

Click on the Step button to execute the current statement and move on to the
next. The debugger steps into the function factorial and the current loca­
tion marker moves to line 25, as shown in figure 3.13.

Figure 3.13 Single stepping through the factorial function

Step 21. Click on the Step button twice more. The current location marker steps through
the factorial function to the next call of factorial on line 27.

A single line of source code may have more than one statement on it. The
cursor will move to the next line when you have stepped through each of the
statements. The statements on a line are numbered from O.
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3 An example ANSI C interactive debugging session

3.3.8 Examining the call stack

Step 22. You can find out where the factorial function was called by examining the
call stack. You do this using the browser window.

The Last Event operation moved the browser to the frame level, so the
browser window already displays the current list of calls with the most recent
at the top. Otherwise you would click on the Call Stack button to display the
call stack.

Notice that there is one call of factorial at the top of the stack. Click on the
Step button again to call factorial again. The new call of factorial will
appear at the top of the stack, as in figure 3.14.

Figure 3.14 Call stack for the factorial function

Step 23. You can display the source code of any of the functions on the stack to see
where the call was made.

Move the cursor to the browser window and click on 'l*main() at <facs. c
49 0>'. The code window changes to display the code of function main, with
the call to factorial marked as the current location. The asterisk {*} in the
browser window line means that the thread was created by main.

Step 24. main and each of the factorial calls has a local variable called n. These
three variables are different and may have different values. Printing the value
of n accesses the n for the current frame.

Double click on n and click on the Print button to display the value of n in main,
which should be 1.

Select the first call to factorial by clicking on '2 factorial () at
<facs. c 27 0>' in the browser window. Select n and print it again. Again it
should be 1, although this is a different variable which happens to have the
same value.

Select the second call to factorial by clicking on '3 factorial () at
<facs. c 25 0>' in the browser window. Print n again. This time it should be
O.
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3.3 Step-by-step tutorial

3.3.9 Stepping over and out of function calls

Step 25. The first call of function factorial is currently waiting for the second call to
finish. The Step Out button has been provided so that you can complete a
function call in a single operation. It has the effect of continuing execution of
the thread back to the current frame or, if no frame is selected, until the current
call has returned.

Select the frame '2 factorial () at <facs.c 27 0>'. Click on the Step
Out button to step out to the selected frame. Notice that the current location
marker stays on line 27. This is because the function result still has to be
multiplied by n and returned. Click on Step Out again to return from the current
call to main.

Step 26. You can continue execution up to a selected statement, by using the Step To
button. This has the same effect as setting a new breakpoint, clicking
Continue, and then removing the breakpoint with Delete.

Select line 53 by clicking on the function name send_next. This line will not
be executed until the factorials of the numbers 1 to 4 have been calculated and
sent.

Figure 3.15 Selecting line 53

Step 27. Now click on the Step To button to continue execution until line 53 is reached.
Notice that the current line marker now rests on line 53 and the message
displayed in the output window is:

2 1 facs main : breakpoint 4 at <facs.c 53 0>

Step 28. If you step through a function using the Step operation you will step into any
functions that are called. If you do not want to step into function calls you can
use the Next operation instead. This steps over function calls, a little like using
a combination of Step and Step Out.

Click on Next and the program will step over the call of send_next. Continue
to click the Next button until the current line marker moves to line 41 , the start
of the while loop.
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3 An example ANSI C interactive debugging session

3.3.10 Listing the current threads

Step 29. The next step of the example session is to list the threads of the app process.
Move the cursor to the browser window and click on the Processes button to
display the list of processes.

Step 30. Select the app process by clicking on 'app'. The browser window shows a list
of the threads that were in app the last time the process was stopped. Only one
thread, main, is listed.

Step 31. To see a list of the current threads, pull down the Execution menu and click
on Find Threads. The cursor will change to a watch while the debugger looks
for the threads. Three new threads will appear, which were generated by a
ProcPar in main. The three new threads are control, sum and feed. None
of these threads is selected so anything you do at this level will be applied to
all the threads.

Figure 3.16 The app process with all threads listed
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3.3 Step-by-step tutorial

3.3.11 Interrupting running threads

Step 32. The next step of the example session is to stop the program by interrupting it.
First you must set all the threads running again.

Move to program level by clicking on the Processes button in the browse
window. Set all the threads running by clicking on the Continue button.

Step 33. To stop a process or thread running you use the Interrupt operation.

Click on the Interrupt button to interrupt all the threads. Notice that the output
window tells you that an interrupt has been requested. Select the app process
and observe that the browser window now shows that threads control, sum,
and feed are all waiting for channel communications. This means that the
threads have not yet reached their interrupt breakpoints because they are
waiting indirectly for the keyboard input.

Figure 3.17 The app process after being interrupted

Move the cursor to the program window and type '6' followed by carriage
return. The control thread changes to stopped since it has now hit its inter­
rupt.

Step 34. You can now look at where the thread has stopped. Click on the Last Event
button to show where the program has stopped. The code window displays the
code for the control thread. This handles the terminal input and output.
Notice that it is currently waiting on a'do ••• while (scanf ( ••• ) •• }'
statement, trying to complete the keyboard input.

Step 35. Click on Continue to set the control thread running again. Click on the
Threads button and observe that the feed thread is now stopped. That means
it has completed its channel input from control and hit its interrupt. Click on
Last Event to show where the interrupt occurred.
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3 An example ANSI C interactive debugging session

3.3.12 Watching communication between two threads

Step 36. You are now going to watch the communication between feed and facs.

Select line 13, containing the ChanOutInt statement, by clicking on it.
Continue execution to line 13 by clicking on the Step To button. Click on the
Threads button to return to thread level.

Step 37. We need to view the source of feed and facs at the same time. The debugger
has an Open Window operation to open another display.

Click on the File menu at the top of the debug display.

Step 38. Select the Open Window option from the File menu. This opens another
debugging display in the same state. On a Sun, a complete duplicate display
is generated, as in figure 3.18.

Figure 3.18 Two X-Windows debugging displays open

On the PC, only an extra code window is generated, as shown in figure 3.19.
The buttons and other windows apply to the code window that is selected. The
Window menu provides operations to tile the code windows, pile them up or
select one.

Make sure that the second display is positioned so that you can see enough
of both code windows.



3.3 Step-by-step tutorial

F¥:I Inquest t~ljiii:
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void send_data (Channel *out, int n)
{

• ChanOutlnt (out, DATA);
ChanOutlnt (out, n);

void send_next (Channel *out)
{

ChanOutlnt (out, NEXT);

ISBAPP.BTL
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Figure 3.19 Two PC code windows open

Step 39. Change the new display to look at the facs thread by clicking on Processes
and then the face process in the browser window. Click on the facs main
thread in the browser window to show the face code. We shall call this window
the facs window and call the other window the feed window. You can tell
which is which by looking at the browser window or the attributes window.

Step 40. The out channel in feed is the other end of the same channel as in in facs.
The feed thread is about to output and facs is waiting to input.

In the feed window, single step over the ChanOutInt statement by clicking
on Step. The facs thread reads the DATA tag, hits its interrupt and stops.

Step 41. In the feed window, Step again for the second output. feed cannot complete
the step as it is now waiting for facs to input from the channel. In the browser
window it is now stepping.

Step 42. In the facs window, click on Step to read the tag. Step again to assign the
result to the variable tag and again to test its value. It is now about to input from
feed. Step once more to complete the input. feed has now also completed
its output.

Step 43. You can now get rid of one of the debug displays.

Click on the File menu at the top of the feed debug display. Select the Close
Window option from the file menu. The feed debug display disappears.

Step 44. Click on Step Out to return to the facs main code.
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3 An example ANSI C interactive debugging session

3.3.13 Setting a watchpoint on a variable

Step 45. You can set a watchpoint on a variable so that every time the variable is about
to be changed the thread stops. You are now going to set a watchpoint on the
n variable that holds the value whose factorial is being calculated.

Highlight the n variable on line 49 of f acs •c by double clicking on it.

Step 46. Set a watchpoint on the highlighted variable by clicking on the Watch button.
Notice that the watch symbol appears next to line 43 where n is declared and
the following message appears in the output window:

watchpoint 7 on <facs.c 43 n> address #8000a174 to #8000a178 of facs main frame

This tells you that the watchpoint is event 7. The addresses give the location
of n. If you scroll the output window up one line you will also see:

2 1 > watch n -1 <facs.c 49>;

Step 47. You now need to set the program running. Click on Processes and then
Continue to restart all the threads. The program will hit the watchpoint and
display in the output window:

2 1 facs main : watchpoint 7 at <comms.c 33 0>

Step 48. You can now examine the value of the variable with the watchpoint.

Click on Last Event to see the watchpoint. The local name for n is *data.
Select the variable data by double clicking on it and then click on the Print *
button to print the value of the variable that data points to. The output window
shows 1, which is the value before it changes. Make one Step, select data
and Print * again to see that it has changed to 2.

Step 49. Click on the Continue button to go on to the next watchpoint.

Step 50. If you want to trace the value of the variable as the thread runs you can make
the debugger do an automatic Print and Continue every time the watchpoint
occurs by issuing a suitable command in the command window.

Move the cursor to the command window and click the left mouse button to
make the window active.

Step 51. Type in the following command, followed by a carriage return:

when (7) {w=step; wait(w); fid=l; write n is (print n); continue}

This tells the debugger that when event 7 occurs it must:

o step (so that n is assigned its new value), saving the event number as w,

o wait until the step completes,
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3.3 Step-by-step tutorial

o move down the stack, so that n is visible, to thread main, which has a fid
of 1,

o output the text 'n is' together with the value of nand

o continue with execution of the program.

Step 52. If you are using a Sun, then the output window is only one line deep. You can
change the height of this window so that you can see a history of the most
recent messages. You do this by dragging the sizing box.

Move the cursor to the output window sizing box, which is the small box at the
top of the scroll bar, as shown in figure 3.20. Notice that the cursor changes
to a cross when it is on the box. Click and hold the mouse button down whilst
you drag the box up the screen. Keep dragging until you have an output
window four lines deep.

Figure 3.20 The Sun output window before re-sizing

Figure 3.21 The enlarged Sun output window

Step 53. Click on the Continue button. The when command will keep printing the value
of n as the facs function increments it to the number you entered then sets
it back to 0 ready for the next input.
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3 An example ANSI C interactive debugging session

3.3.14 Deleting a watchpoint

Step 54. You can now delete the watchpoint you set on n. Click on Last Event to locate
to the watchpoint again.

Step 55. To set a watchpoint we selected a variable. To delete the watchpoint we select
the declaration line. Select line 43 of facs •c by clicking on it. This line is the
declaration of n, which has the watchpoint symbol, <3 on Suns or G on PCs,
on it.

Figure 3.22 Line 43 with watchpoint set

Step 56. With the declaration line selected, click on the Delete button to remove the
watchpoint. The watchpoint symbol disappears.

Step 57. Click on the Continue button.

Step 58. Type in another number at the prompt 'Please type n :'.

The program now executes normally since the watchpoint has been removed.
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3.3.15 Jumping down a channel

To explore the wider context of a thread we may wish to look at the threads that
communicate with it. To find a thread that is waiting for a communication, we can jump
down a channel. This means that we are changing context to the thread that is waiting
for communication on that channel.

At most one thread can ever be waiting for one channel; when two threads are ready
then communication starts. If no thread is waiting then the Jump operation will not
change the context. If the current thread is waiting then, again, the Jump operation will
not change the context.

Step 59. Thread facs has a send_data function call at line 49 which sends data down
the channel to the next thread. You are now going to use this statement to jump
to the thread that is waiting on the other end of the channel.

First you must interrupt execution of facs, as facs must be stopped. Set an
interrupt on facs by clicking on the Interrupt button.

Step 60. Enter a value for n in the program window. The attribute window should show
that the facs thread has stopped at the interrupt.

Step 61. The interrupt has left the current line inside the read_chan function. Move
back down the frame stack to the main thread by clicking on 'l*main<) at
<facs. c 45 0>. The call to send_data should now be visible again on line
49. Double click on the name of the channel out to select it.

Step 62. Click on the Jump button. The context changes to the process square, which
is waiting for input. This is the other end of the output channel from facs.

3.3.16 Leaving the debugger

Step 63. You have now finished the example interactive debugging session. If you want
to exit from the debugger, click on the File menu and select the Exit or Quit
option. A pop-up dialog box will appear asking you to confirm the exit request.
Select Yes and the debugger will close its windows and exit.

On PC systems, you may wish to also close the ISERV window.

This concludes the tutorial for interactive debugging with C programs.
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4 An example ANSI C post-mortem
debugging session

This chapter takes you in detail, step by step, through one example post-mortem
debugging session, to demonstrate the features that are available for post-mortem
debugging, using an ANSI C program as the example. A similar occam example is
described in chapter 6.

This chapter shows you how to:

build the program for post-mortem debugging;

• start the debugger when the program fails;

• locate where the crash has occurred and the reason for it;

examine a variable;

• examine a call stack;

• jump down a channel;

• quit from the debugger.

Before starting the session you need to know a little about the example program. This
is the same program as is used in chapter 3, so if you have not worked through the
interactive debugging session, rea~ section 3.1 before proceeding.

Before starting the tutorial you may find it useful to have a listing of the example program
source code. It would also be useful to look at figure 2.1 or figure 2.2 in section 2.4 to
show you the names of the parts of the debugger display.

4.1 Post-mortem debugging

Post-mortem debugging means debugging after the program has crashed, terminated
or been stopped. It may have crashed during normal running or during an interactive
debugging session. In this tutorial, we shall start from normal execution. Starting from
an interactive session is easier and is described in section 2.4 of chapter 2 in the
INQUEST User and Reference Manual.

During post-mortem debugging you can navigate through the code and explore the
state of the program exactly as in interactive debugging. However, the program cannot
be restarted, so stepping, interrupts, breakpoints and watchpoints do not apply.

4.1.1 Building the code

Post-mortem debugging only requires that the code has been compiled with full debug­
ging data, Le. with the G option.
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4.1 Post-mortem debugging

On Sun systems, the example program makefile builds the example application for you
and is called makefile. On a PC, a batch file called build. bat is provided to do this.
This generates a bootable file for post-mortem debugging called app-pm.btl.

For the purposes of this tutorial, all the processes are configured to run on the same
processor.

4.1.2 Starting post-mortem debugging

When a program crashes during normal execution then the host is returned to the state
before the program was run. Post-mortem debugging can then be started by the
inquest command.

On a PC this can be done from the File Manager by double clicking on the
inquest. exe program, which makes a command line box pop up. The browse button
is used to select the application app-pm.btl. The -pm option is added in the Options
box to request post-mortem debugging.

On a Sun this is done by typing the inquest command at the operating system prompt
with the -pm option to request post-mortem debugging:

inquest app-pm.btl -pm

The debugger will analyze the target hardware. This means that signals will be sent to
the target to halt any threads that may be still running, and then the hardware will be
reset without losing any state information. After analyzing the target, the debugger uses
a network mapper to explore the state of the target. The debugging display will then
appear on the screen.

If the error flag was set, then a message will appear showing where the error occurred.
The source line where the error happened is automatically located by the debugger. The
process causing the error can then be explored and other processes located using
Jump.
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4 An example ANSI C post-mortem debugging session

4.2 Step-by-step tutorial

Here is a step-by-step tutorial to guide you through the main features of INQUEST
post-mortem debugging.

Step 1. Move to the app_c sub-directory in the examples directory which contains
the ANSI C example program app--'pm.

Step 2. Check that the TRANSPUTER, ASERVDB and ISEARCH environment parame­
ters are correctly defined.

Step 3. The root transputer must be an IMS T400, IMS T425, IMS T801, IMS T805,
ST20450 (T450) or IMS T9000. The example is configured for a single ST20
or for a single IMS T9000 depending on the INQUEST version.

If you are using a different type of root transputer then you will need to edit:

o the hardware configuration file, hardware;

o for Suns the make macro file tools or for PCs the build batch. file
build.bat.

The changes to make in each case are given in table 4.1.

Target All users: Sun users only: PC users only:
file hardware file tools file build.bat

ST20450 IT450 No change No change No change

IMS T9000 No change No change No change

IMS T400 or T425 Change T4s0 to T425 Change 450 to 425 Change t4s0 to t42s

IMS T801 or T805 Change T4s0 to T80s Change 450 to 805 Change t4s0 to t80s

Table 4.1 Changes to examples to support different targets

Step 4. Create a bootable file, suitable for debugging. To do this on a Sun, at an
operating system prompt type:

make

On a PC, type:

build
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4.2 Step-by-step tutorial

4.2.1 Starting and crashing the application

Step 5. Start the example application, app-pm.btl, which is the bootable code for
post-mortem debugging that you created in Step 4.

On Sun systems this is done by typing:

irun app-pm.btl

On PC systems, start up Windows, open the File Manager and double click on
the inquest. exe program. This will open the Command line dialog box. Use
the browse button next to the File field to find and select the application
app.....Pm. btl in the app_c sub-directory in the examples directory. Click on
the Run button in the Command line box.

Since the code has not been configured for debugging, this loads the applica­
tion for normal execution onto the target hardware. The parameters you can
give to irun are described fully in the irun chapter of your Toolset Reference
Manual.

Step 6. The program will ask for a number with the prompt:

Sum of the first n (n < 9) squares of factorials
Please type n :

Enter the number 6 to make the program continue.

Step 7. Next time the program asks for a number, enter Control-C. This will halt the
server. The application program will continue running until the target hardware
is analyzed when the post-mortem debugger is loaded. In this case, the
program is waiting for keyboard input, so the state will not change.

4.2.2 Starting the debugger

Step 8. On PC systems, in the File Manager, double click on the inquest. exe
program. This will open the Command line box again. Use the browse button
again next to the File field to find and select the application app.....Pm.btl in
the app_c sub-directory in the examples directory. This time type -pm in the
Options field to tell INQUEST to do a post-mortem debug. Click on the Run
button in the Command line.

On Sun systems, start the post-mortem debugger with the command:

inquest app-pm.btl -pm

Step 9. Wait while a debugging display is created. This will show the configuration file
in the code window and a list of the example program's processes in the
browser window. This is the program level display. Figure 4.2 shows the X-Win­
dows display; the PC display is shown in figure 4.1. The debugger has explored
the target hardware and is showing the last known state of the program when
it was stopped. If the program had set the error flag, then the debugger would
have automatically located to where the error occurred.
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4 An example ANSI C post-mortem debugging session

I§!I Inquest
File Execution Events Variables Options Window Help

§iii Program: APP PM.BTL I*,l~:

C:\INQUESnEXAMPlES\APP C\app.cfs

(D 1******************************************* 't

*********************** Copyright INMOS Lim:;'·.::..... :.

1
2
3
4
5
6
7
B
9
10

* File
* Author
* Last modified by
* Date modified
* Version
* Notes

$RCSfile: app .cfs. v $

$Author: mikej $ : ..:
$Date: 1994/12/1912:0:·:
$Revision: 1.2 $

: C_app example cfs file ;.: :

Figure 4.1 The Microsoft Windows start-up display for the example program
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4.2 Step-by-step tutorial

4.2.3 Using the browser

Step 10. Since the program was halted by stopping the host server, and since the
program had not deadlocked, we would expect that the control thread would
be waiting for a host communication. We will use the browser to check this.

To tell INQUEST to search for the threads, click on Find Threads in the
Execution menu. Move the cursor to the browser window, where the three
processes square, facs and app are listed. The control thread is part of the
app process, so click on app. This moves the display to process level, with the
browser window showing a list of threads in the process with their states, as
shown in figure 4.3. All the threads are waiting for channels. We would expect
this because the threads continued to run until they were halted by waiting for
a communication with another halted thread. The code window shows app. c.

Figure 4.3 Process level browser display

Step 11. To move to the control thread, click on 'app control: chan-waiting'.
The display changes to the thread level display, as shown in figure 4.4. The
selected thread is highlighted and the code window shows the source code for
the control thread, with the next statement marker, [2J on Suns or I> on pes,
on the line that was waiting to complete, as shown in figure 4.5.

:~:~;:ij~li!R~;"';~:';\):'~;:'~~"':;·:':::'i':",:i:~;':1
Figure 4.4 Thread level browser display

Figure 4.5 control thread
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4 An example ANSI C post-mortem debugging session

4.2.4 Examining the call stack

Step 12. The next statement marker, (2J on Suns or I> on pes, is in the function
read_next_n. You can find out where this function was called by using the
call stack.

To see the call stack, move to the frame level by clicking on the Call Stack
button in the browser window. This changes the browser window to show the
call stack~

Each line of the call stack represents a function call in the current thread which
has not yet returned. The last few calls are to routines used by scanf. scanf
itself is at line 6, so scroll down to this line, so that the browser window looks
like figure 4.6.

The top functions are system functions so they have no debugging data; the
debugger only knows that the code is in the library libc .lib. The next line
of the browser window shows that scanf was called by read_next_n at line
30 in source file control. c. read_next_n was called by control at line
59. control was called by main at line 50 of app. c, using ProcPar and
ProcParList%c.

Figure 4.6 Call stack for the factorial function

Step 13. You can display the source code of any of the functions on the stack to see
where the call was made.

Move the cursor to the browser window and click on '4*control() at
<control. c 59 0 >'. The code window changes to display the code of
function control, with the call to read_next_n marked with the next state­
ment marker, [2] on Suns or~ on PCs. The asterisk (*) in the browser window
line means that the thread was created by control.

Step 14. Click on 'l*main () at <app. c 50 0>' to show the line where control was
called; the ProcPar statement.

Return to the control frame by clicking on '4*control () at <control. c.
59 0>' in the browser window.



4.2 Step-by-step tutorial

4.2.5 Examining a variable

Step 15. You are now going to examine the value of a variable.

Place the cursor on the variable 'n' on line 54, 59, 61, 64 or 67, and highlight
it by double clicking the left mouse button. This causes the whole word to be
selected, which in this case is just the single letter.

Step 16. Display the value of the variable by clicking on the Print button. The Print
operation displays the value in the output window; it does not produce a hard
copy. The output window should show the message:

6

This tells you that n has the value 6, which was the value you last typed in.

Moving up and down the stack, examining the variables at each level, gives
you a clear view of what happened to the thread just before it crashed.

42 ~SIiS-1HOMSON
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4 An example ANSI C post-mortem debugging session

4.2.6 Jumping down a channel

To explore the wider context of the current thread we may wish to look at the threads
that communicate with it. To find a thread that is waiting for a communication, we can
jump down a channel. This means that we are changing the context to the thread that
is waiting for communication on that channel.

At most one thread can ever be waiting for one channel; when two threads are ready
then communication starts. If no thread is waiting then the Jump operation will not
change the context.

Step 17. Move back to the control function by selecting it on the call stack.

Step 18. Select the channel in by clicking twice on a reference to it. Click on the Jump
operation button to jump down the in channel. The in channel is empty, Le.
no thread is waiting for it, so nothing happens, except that the message

*empty*

appears in the output window.

Step 19. Select the channel out by clicking twice on it. Click on the Jump operation
button to jump down the out channel. The context will change to the feed
thread, which is waiting for input on this channel, which is called in within the
feed function. The next statement marker shows exactly which input the
thread is waiting for.

Step 20. If we want to jump to the next thread in the pipeline then we need to use the
channel out in feed. This channel is not in scope, because we are in the
function read_chan which does not use channel out. To come out of
read_chan, click on the Call Stack button in the browser window to show the
call stack and select the line below read_chan, which says '4*feed at
<feed.c 27 0>'. The context changes to the feed function, with the out
channel in scope.

Step 21. Select the out channel in feed and click on the Jump operation button again.
The context will change again to the facs thread, which is waiting for input on
this channel, which is called in within the facs procedure.

4.2.7 Leaving the debugger

Step 22. You have now finished the example post-mortem debugging session. If you
want to exit from the debugger, click on the File menu and select the Exit or
Quit option. A pop-up dialog box will appear asking you to confirm the exit
request. Select Yes and the debugger will close its windows and exit.

This concludes the tutorial for C programs on post-mortem debugging.

____________ ~5tmal.~ 4_3_
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5 An example occam interactive
debugging session

This chapter takes you in detail, step by step, through one example interactive debug­
ging session, to demonstrate the basic features of the INQUEST debugger, using an
occam program as the example. A similar ANSI C example is described in chapter 3,
and post-mortem debugging is shown in chapter 6.

This chapter shows you how to:

build the program for debugging;

• start the debugger;

place a breakpoint;

• start the processes running;

• locate where a breakpoint has occurred;

examine a variable;

remove a breakpoint;

single step through the source code;

examine a call stack;

step over function calls;

• interrupt a running process;

• watch communication between two threads;

• set a watchpoint on a variable;

• delete a watchpoint;

• jump down a channel;

• quit from the debugger.

Before starting the session you need to know a little about the example program. This
is described in section 5.1 below.

5.1 The example program

The example debugging session uses an example program called app, which you will
find in the directory app_occ within the examples directory. The directory contains all
the source code and makefiles.



5.1 The example program

This is a simple multi-process program. The processes are arranged in a pipeline that
generates the sum of a series of squares of factorials, as in the following formula:

n

'I factorial(i) 2

i=1

It is not an efficient program, but it provides the structures we need to try out the
debugger. The program consists of five configuration-level processes; control, feed,
facs, square and SUlD.

The debugger uses slightly different terminology from the usual occam terms in order
to distinguish between static and dynamic processes. All the processes listed above,
control, feed, facs, square and sum, are all called threads. They are mapped onto
the processor RootNode in the configuration code. The debugger calls all the code on
one processor a process and gives it the name of the processor with a -p suffix. The
example program has only one process, RootNode-p. If you have more than one
processor available, you may wish to re-configure the program for three processors so
that you can see a program with more than one process.

Figure 5.1 shows how the threads connect together.

Host

Figure 5.1 The example program

control - displays the message

Sum of the first n (n < 9) squares of factorials

and asks you to type in a value for n. Numbers bigger than 8 would cause an
overflow. The number you type is sent to feed. Zero or negative numbers
terminate the program.

feed - receives the number n from control and sends all the numbers from
1 to n to facs, one at a time. It then sends a signal, next, to say that this batch
of data is complete.

facs - generates the factorial of each number it receives from feed, and sends
the result to square. It passes on the signal next to square.
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5 An example occam interactive debugging session

• square - generates the square of each number it receives from facs and
sends the result to sum. It passes on the signal next to sum.

sum - generates the sum of all the numbers it receives from square until it
receives the signal next. On receiving next, sum passes the result on to
control.

control - displays the result it received from sum.

To terminate the program you type zero in response to the 'Please type n
message issued by control. This causes the signal end to be passed down the
pipeline. Each thread dies after it has passed on end.

Before starting the tutorial you may find it useful to have a listing of the example program
source code. It would also be useful to look at figure 2.1 or figure 2.2 in section 2.4 to
show you the names of the parts of the debugger display.

5.2 Building the example program

Any occam program that you want to debug must be built in the following way:

Compiled using oc without the D option.

Linked using i1ink.

• Configured using occonf with the GA option.

Collected using ico1lect.

On Sun systems, the example program's makefile does all this for you and is called
makefi1e. On a PC, a batch file called build.bat is provided to do this. This gener­
ates a bootable file for interactive debugging called app. bt1.

The contents of the configuration file app. pgm are shown in figure 5.3. The configura­
tion #:INCLUDES the hardware configuration file hardocc, shown in figure 5.2.

For the purposes of this tutorial, all the threads are configured to run on the same
processor so there is only one process.

VAL K IS 1024:
VAL M IS K * K:

NODE RootNode:
ARC HostLink:
NETWORK

DO
SET RootNode (type, rnernsize := "T450", 512K)
CONNECT RootNode[link] [0] TO HOST WITH HostLink

Figure 5.2 ST20450 hardware configuration hardocc
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5.2 Building the example program

#INCLUDE "hardocc"
#INCLUDE "hostio.inc"
#INCLUDE "pipe. inc"

#USE "control.lku"
#USE "feed.lku"
#USE "facs.lku"
#USE "square.lku"
#USE "sum.lku"

CONFIG
CHAN OF SP fs, ts:
PLACE fs, ts ON HostLink:
CHAN OF PIPE control.to.feed, feed.to.facs:
CHAN OF PIPE facs.to.square, square. to. sum:
CHAN OF PIPE sum.to.control:

PROCESSOR RootNode
PAR

control (fs, ts, sum. to. control , control.to.feed)
feed (control.to.feed, feed.to.facs)
facs (feed.to.facs, facs.to.square)
square (facs.to.square, square. to. sum)
sum (square. to. sum, sum. to. control)

Figure 5.3 Configuration source code app. pgm
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5 An example occam interactive debugging session

5.3 Step-by-step tutorial

Here is a step-by-step tutorial to guide you through the main features of the INQUEST
debugger used for interactive debugging.

Step 1. Move to the app_occ sub-directory in the examples directory which contains
the occam example program app. Run the set-up script to set up the environ­
ment, as follows.

On Sun systems, at a prompt type:

source setup.csh

or

. setup.sh

On PC systems, at a DOS prompt type:

setinq

Step 2. Check that the TRANSPUTER parameter is correctly defined.

Step 3. The root transputer must be an IMS T400, IMS T425, IMS T801, IMS TaOS,
ST20450 (T450) or IMS T9000. The example is configured for a single ST20
or for a single IMS T9000 depending on the INQUEST version.

If you are using a different type of root transputer then you will need to edit:

o the hardware configuration file, hardocc;

o for Suns the make macro file tools or for PCs the build batch file
build.bat.

The changes to make in each case are given in table 5.1.

Target All users: Sun users only: PC users only:
file hardocc file tools file build.bat

ST20450 I T450 No change No change No change

IMS T9000 No change No change No change

IMS T400 or T425 Change T450 to T42s Change 450 to 425 Change t4s0 to t42s

IMS T801 or T805 Change T450 to T80s Change 450 to 805 Change t4s0 to t80s

Table 5.1 Changes to examples to support different targets

Step 4. Build a bootable file, suitable for debugging. To do this on a Sun, type at an
operating system prompt:

make

On a PC, type:

build



5.3 Step-by-step tutorial

5.3.1 Starting the debugger

Step 5. Start the debugger with the example program, app. btl, which is the bootable
code you created in Step 4.

On Sun systems type:

inquest app.btl

On PC systems, start up Windows, open the File Manager and double click on
the inquest. exe program. This will open the Command line dialog box. Use
the browse button next to the File field to find and select the application
app.btl in the app_occ sUb-directory in the examples directory. Click on
the Run button in the Command line.

This loads the debugger onto the host computer and a small kernel of debug­
ger code onto each processor of the transputer network that has processes to
be debugged.

The parameters you can give to inquest are described fully in the INQUEST
User and Reference Manual.

Step 6. Wait while a debugging display is created. This will show the configuration file
in the code window and a list of the example program's processes in the
browser window. This is the program level display. Figure 5.4 shows the PC
display; the X-Windows display is shown in figure 5.5.

#.#.1 Inquest
File Execution Events Variables Options Window Help

1
2
3
4
5
6
7
8
9

10

_. .-- OCC\ann,oam

IIINCLUDE ·hardocc·
IIINCLUDE ·hostio. inc·
IIINCLUDE ·pipe.inc·

IIUSE ·control.lku·
IIUSE ·feed.lku·
IIUSE • facs .lku·
IIUSE • square. lku·
IIUSE • sum .lku·

JI=====:::IS:::':E=R~V==/S~B=::A==PP.==:.B=T==L======:::r.:r"'::;:;:::::)JF:i;mrI

I
(f

rF""",jl_-;=ln=q=ue=s=t'~=B=ro=w=s=er====='t=:'W=/~~::;::I§I Inquest - Cmdline

I"-IS-EA-RC-H~:l=:=~=~=N·=:=~C=:\inq=U=es=t\Ii=b =====:;;:;:J I00> I I~
I

Figure 5.4 The Microsoft Windows start-up display for the example program
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5 An example occam interactive debugging session

Figure 5.5 The X-Windows initial display for the example program

On a PC a new input and output window is created for the application, labelled
something like ISERV ISB APP. BTL. On a Sun, the input and output of the
program being debugged will be shown in the window that the debugger was
started from. In either case, this will be called the program window in the rest
of this document.

The transputer program has been halted a few instructions before the begin­
ning of each process.

----------- LT~~~Lll'a.I-----------5-1



5.3 Step-by-step tutorial

5.3.2 Single stepping

Step 7. You are now going to step through the configuration code until some more
threads are generated. Move the cursor to the browser window and click on
the only process 'RootNode-p'. This changes the browser to process level,
giving a list of threads in the browser window. Click on the only thread
'RootNode-p main: stopped at <app.pgm 0 0>' to select it. This
changes the browser to thread level.

Step 8. occam programs are initially stopped several steps before the start of the user
code. To start at the PAR statement in the configuration code, use the scroll bar
on the right of the code window to scroll the window down, and click on the PAR
on line 19. The selected line marker, ~ on Suns or ~ on PCs, will move
alongside the statement. Click on the Step To button to step through the initial
code up to the selected line. The current line marker, [2J on Suns ort> on PCs,
moves next to the selected line marker on line 19.

Step 9. Click on Step to start the PAR. The browser window says that the thread is
stepping. It cannot complete the Step until the PAR has terminated, Le. until
control, feed, facs, square and sum have all terminated. The Step button
turns grey, since the thread cannot step again until the current step has
completed.

Step 10. The threads control, feed, facs, square and sum have now been gener­
ated, and they are listed in the browser window. The window is not big enough
for five threads, so to see the line for thread RootNode-p main [5] , scroll
down using the scroll bar on the right of the browser window. Thread
RootNode-p main is the top level process which cannot continue until the
PAR has terminated. Threads RootNode-p main [1] to [5] are the
processes control, feed, facs, square and sum respectively, in the same
order as they are listed in the PAR.

Figure 5.6 facs procedure code window
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5 An example occam interactive debugging session

Step 11. We can now look at the facs thread, which is stopped. Select it by clicking on
'RootNode-p main[3]: stopped at <app.pgm 37 0>' in the browser
window. In the code window, the line markers move to the facs procedure call.
Click on the Step button to enter the facs procedure and the code window will
display the code for the procedure. The browser window should look some­
thing like figure 5.7, and the code window like figure 5.6.

Figure 5.7 facs procedure browser display

------------ E;l1f~~\91-----------5-3



5.3 Step-by-step tutorial

5.3.3 Placing a breakpoint

Step 12. You are now going to place a breakpoint in the faes thread on line 37, which
is the output on channel to. square. Use the code window scroll bar to scroll
down to line 37. Select line 37 by clicking on the statement. The selection line
marker ($ on Suns or <> on PCs) appears alongside the statement. Click on
the blank space after the statement to ensure that no text is highlighted.

Step 13. Click on the Break button to set a breakpoint at the selected line. A breakpoint
marker ( 0 on Suns or~ on PCs) appears alongside the selected line marker.

Figure 5.8 Source code after the breakpoint has been set

Notice that the output window at the bottom of the debug screen displays a
message telling you about the breakpoint you have just set:

breakpoint 2 at <facs.occ 37 0> iptr #8000 ••• of RootNode-p main[31

This means the breakpoint has been labelled event number 2. It has been set
at the start of line 37 of the file faes •oee. The part in chevrons, '<faes .oee
37 0>', means the zeroth step of line 37 of the file faes . oee. The breakpoint
has been set in the code at address #8000.... If you scroll the output window
up one line, you will find:

1 4 > break <facs.oee 37 0>

A breakpoint has been set in process 1, thread 4, which is main [3]. The
breakpoint applies only to the currently selected thread, main [3] , and will
cause execution of the thread to stop when this line is about to be executed.
If other threads were using the same code they would not be affected.

A breakpoint set at process level would act on all the threads in the currently
selected process. It would give a message like:

1 0 > break <faes.oee 37 0>

The '1 0 >' would mean all threads of process 1.
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5.3.4 Starting the example program

Step 14. Having set a breakpoint you are now ready to start the example program. If you
were to click on the Continue button at this level you would only start the facs
thread running. To ensure that all the threads are set running you must use the
browser to return to the program level.

Move the cursor to the browser window and click on the Processes button to
display the list of processes. The browser window changes to look like figure
5.9. This is the top level of the browser, the program level.

Figure 5.9 Browser window showing the example program's processes

Step 15. At this level you can start all the processes by clicking on the Continue button.

Notice that the output window displays the message:

o 0 > continue

The '0 0 >' means all threads of all processes. A non-zero number would
refer to a specific process or thread.

Step 16. As the app program runs it displays the following message in the program
window:

Sum of the first n (n < 9) squares of factorials
Please type n :

Move the cursor to the program window and type '4' followed by return.

The output window should now display the message:

1 4 RootNode-p main[3] : breakpoint 2 at <facs.occ 37 0>

This tells you that a breakpoint has occurred in facs •occ at line 37 for thread
4 of process 1. This should come as no surprise as it is where you set the
breakpoint in step 13.
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5.3.5 Locating where a breakpoint has occurred

Step 17. To display the code where the breakpoint has occurred, click on the Last Event
button. This brings you to frame level, as in figures 5.10 and 5.11.

Figure 5.10 Browse window after the breakpoint has been located

Figure 5.11 Code window after the breakpoint has been located

5.3.6 Removing a breakpoint

Step 18. The breakpoint has served its purpose, so you can now delete it. Check that
line 37 is still the current line and click on the Delete button. The breakpoint
marker disappears.
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5.3.7 Examining a variable

Step 19. You are now going to examine the value of a variable.

Click twice on the variable en' on line 27, 36 or 37 to select it. Clicking twice
selects the whole of the word where the cursor is.

Step 20. Display the value of the variable by clicking on the Print button. The Print
button displays the value in the output window; it does not produce a hard copy.

The output window should now display the simple message:

1

This tells you that n has the value 1, so the factorial function is about to
compute the factorial of 1.
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5.3.8 Single stepping through the source code

Step 21. Since this thread is stopped you can step through the code and follow the
execution path.

Line 37, the current location, includes a call to the factorial function. When
you Step on a call to a function or procedure you will step into the function or
procedure.

The debugger treats line 37 as three steps:

to send the tag data,

to call the factorial function and

to send the result of factorial.

Click on the Step button to send the data tag. Step again to step into the
function. The code display changes and the current location marker moves to
line 12, the beginning of the definition of factorial, as shown in figure 5.12.

Figure 5.12 Single stepping through the factorial function
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5.3.9 Examining the call stack

Step 22. You can find out which line has called the factorial function by examining
the call stack. You do this using the browser window to go to frame level.

Normally you would move the cursor to the browser window and click on the
Call Stack button, but Last Event left the browser at frame level, so there is
no need to do this. At frame level the browser window displays the call stack,
which is a list of function and procedure calls, with the most recent call at the
top, as in figure 5.13.

Figure 5.13 Call stack for the factorial function

Step 23. You can display the source code of any of the frames to see where the call was
made to the next frame in the stack.

Move the cursor to the browser window and click on '2 facs () at
<facs .occ 37 1>'. Observe that the code window changes to display line
37 of the code of the procedure facs, with the output to to. square (including
the call to factorial) marked as the current line, as in figures 5.14 and 5.15.

Figure 5.14 Frame facs () selected

Figure 5.15 Frame facs () code

Click on 'l*main() at <app.pgm 37 0>'. The code window changes
again to display the configuration code with the current line marker on the call
to facs. Click on '3 factorial () at <facs. occ 12 0>' to return to the
factorial function.
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5.3.10 Stepping to

Step 24. You may want to continue execution up to a particular statement. This can be
done by selecting the statement that you want and using the Step To button.
This has the same effect as setting a new breakpoint, clicking Continue and
then removing the breakpoint with Delete.

Select line 20 by clicking on the statement on line 20. Now click on the Step
To button to continue execution until line 20 is reached. The current line marker
moves to line 20.

5.3.11 Stepping out of function calls

Step 25. You can step out of this call of factorial using the Step Out button. This has
the effect of continuing until a function or procedure returns or, with a frame
selected, Step Out will continue until it reaches the current frame. You could
of course continue to single step using the Step button, but this would be
tedious and take longer.

Click on the frame '2 facs () at <facs. occ 37 1>' and then click on the
Step Out button. The current location marker stays on line 37 but the call stack
changes. This is because the function has returned but the result still has to
be sent down the channel to. square.

Figure 5.16 After stepping out
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5.3.12 Stepping over function calls

Step 26. If you step using the Step operation you will step into any functions or proce­
dures that are called. If you do not want to step into function and procedure
calls, then you can use the Next operation instead. This has the same effect
as Step except that function and procedure calls are stepped over, a little like
using a combination of Step and Step Out.

Click the Next button until the current line marker moves back to line 37. Click
the Next button twice more. The first Next sends the data tag and the second
steps over the call to factorial and sends the result.
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5.3.13 Interrupting running threads

Step 27. The next stage of the example session is to stop all the threads by interrupting
them. First you must set the facs thread running again.

Move up to thread level by clicking on the browser Threads button. Set the
facs thread running by clicking on the Continue button. This should mean all
the threads are running except the top level thread which is stepping. The
program will wait at the next keyboard input in the state shown in figure 5.17.

Figure 5.17 The process with all threads running

Step 28. To stop a process or thread running you use the Interrupt operation.

Move up to the process level by clicking on the Deselect button. Click on the
Interrupt button to interrupt all the threads. The threads main [1] to main [5]
should all have changed in the browser window from 'running' to 'chan­
waiting'. An interrupt breakpoint has been set but 'chan-waiting' means the
thread has not reached it because the thread is waiting for channel commu­
nications. The output window shows:

1 0 > interrupt

which means that interrupts have been set on all the threads of process 1.

Step 29. Move the cursor to the program window and type '6' followed by return. No
echo appears since the echoing thread has been interrupted. The state of the
control thread, main[l], should now be something like 'stopped at
#8000 ••• '. The other threads are still 'chan-waiting' because they are waiting
for channel communications. The output window says:

1 2 RootNode-p main[1]: interrupted at #8000 •••

This shows that main[l], the control thread, has been interrupted.

Step 30. You can now look at where the program has stopped.

Click on Last Event to show where control was interrupted. The browser
window shows that the interrupt was in the VIRTUAL. IN () routine in the
virtual. lib library module. This library and hostio. lib do not have
symbolic debugging data so the code cannot be displayed for the frames
7 VIRTUAL. IN ( ) , 6 sp. getkey, 5 so. read. echo. 1 ine and 4
so. read. echo. into All the debugger can tell us about these routines is
which library they are in, although we could look at the disassembled code if
we needed to. The debugger therefore shows us the code for the frame which
called the code with no debugging data.

3 read.next.n() at <control.occ 23 0>
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5 An example occam interactive debugging session

We know this frame has full debugging data because the part '<control 23
0>' means the debugger has identified the source line as line 23 in the source
file control.occ. The current line marker shows that it is calling
so. read. echo. int, which is what we expected from the call stack.

Step 31. Now click on the Threads button to return to threads level and set control
running again by clicking on Continue. The browser window should show that
control is now 'running'. The Continue only applies to the control thread
because that thread is selected in the browser window. This allows control
to complete its channel communication with feed; feed then hits its interrupt
and becomes 'stopped at #8000 ..• '.

Step 32. Click on the Last Event button to find where this interrupt occurred. The code
window shows that it was in feed on line 19.
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5.3.14 Watching communication between two threads

Step 33. You are now going to watch the communication between feed and facs. We
need to view the sources of feed and facs at the same time. The debugger
provides an Open Window operation to allow you open another window to do
this.

Click on the File menu at the top of the debug display.

Step 34. Select the Open Window option from the File menu. This opens another
debugging display in the same state. On a Sun a complete duplicate display
is generated, as in figure 5.18.

Figure 5.18 Two X-Windows debugging displays open

On the PC, only an extra code window is generated. The buttons and other
windows apply to the code window that is selected. The Window menu
provides operations to tile the code windows, pile them up or select one.
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91 Inquest
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Figure 5.19 Two PC code windows open

Make sure that the second display is positioned so that you can see enough
of both code windows.

Step 35. Move the cursor to the second debug window. We want to display the thread
facs, which should be waiting to read input. Go up to thread level by clicking
on the Threads button and select 'RootNode-p main [3]
chan-waiting'. It is, of course, waiting an input from feed. We will call this
window the facs window.

Step 36. Move the cursor to the first debug window. We will call this the feed window.
You can tell which window is which from the file name in the attribute window
or the frame stack in the browser window.

Step 37. In the feed window, select line 23 by clicking on it. This is the line containing
the output statement that sends to f acs. Continue execution of feed up to line
23 by clicking on the Step To button. In the attribute window, feed is now:

1 3 RootNode-p main[2]: stopped at <feed.occ 23 0>

facs is waiting for input, so in the attribute window of the facs window we
have:

1 4 RootNode-p main[3]: chan-waiting
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Step 38. In the feed window, click on Step to send the first part of the output, the tag
datao feed is now on the second step of the statement, so the attribute
window now says:

1 3 RootNode-p main[2]: stopped at <feed.occ 23 1>

Step 39. Executing this step has also had an effect on facs. The facs thread has now
read the tag and hit its interrupt. This can been seen from the facs attribute
window which has changed to:

1 4 RootNode-p main[3]: stopped at #8000 •••

In the facs window, click on Last Event to see the interrupt. Click on Step to
complete the call of VIRTUAL. IN, which disappears from the call stack and
the attribute window changes to:

1 4 RootNode-p main[3]: stopped at <facs.occ 35 2>

Step 40. Click on Step again to test the tag to see whether the communication is data,
next or end. The attribute window becomes:

1 4 RootNode-p main[3]: stopped at <facs.occ 36 0>

Step 41. Step again to read in the second part of the data. The thread cannot complete
the input and so it has to wait for the sender again before the step can
complete. The attribute window says:

1 4 RootNode-p main[3]: stepping

Step 42. Change to the feed window, which is still stopped at <feed. occ 23 1> and
click on Step. This sends the second part of the data and completes the
communication. The line marker moves on to line 22 for the next iteration of
the loop. The attribute window changes to:

1 3 RootNode-p main[2]: stopped at <feed.occ 22 0>

Meanwhile, in the facs window, the input has completed and the line marker
has moved to line 37. The attribute window has changed to:

1 4 RootNode-p main[3]: stopped at <facs.occ 37 0>

Step 43. You can now close the facs window by clicking on the File menu at the top
of the facs window and selecting the Close Window option from the File
menu. The window disappears.
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5.3.15 Setting a watchpoint on a variable

Step 44. You can set a watchpoint on a variable so that the thread stops every time the
variable is about to be changed. You are now going to set a watchpoint on the
n variable that holds the input data.

Highlight the n variable on line 18, 20 or 22 of feed by double clicking on it.

Step 45. Set a watchpoint on the highlighted variable by clicking on the Watch button.
Notice that a watch symbol, 0 on Suns or (t on PCs, appears next to the
declaration of n and the following messages appear in the output window:

1 3 > watch n -1 <feed.occ 18>;
watchpoint 6 on <feed.occ 18 n> address #8000 .• to •••

Scroll the window up to see the first line. When the watchpoint occurs the
thread will stop.

Step 46. You now need to set the program running.

Move the cursor to the browser window and click on the Processes button.

Step 47. Click on the Continue button to set all the threads running. If you had not
clicked on Processes before doing a Continue you would only have set
thread feed running. The output window displays the message:

o 0 > continue

Step 48. The program window displays the result:

The result was : 533417

Type '3' at the prompt 'Please type n :'

When the program hits the watchpoint, the output window displays the
message:

1 3 > RootNode-p main[2] : watchpoint 6 at #8000 .••

Step 49. You can now examine the value of the variable with the watchpoint.

Click on Last Event to show the code where the watchpoint occurred. Select
the variable n by double clicking on it and then click on the Print button. It will
display the value 6, as the value has not changed. Step once and Print n again
and it will have changed to 3.

Step 50. Click on the Threads button to go up to process level.

Step 51. We can look at the list of current watchpoints by means of the List Watch­
points operation. Click on the Events menu and select List Watchpoints. A
window pops up with two watchpoints, both watchpoint 6.
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One is set on a thread, so that if another instantiation of n were defined then
the watchpoint would apply to that n too. The other is set on a range of
addresses and is the watchpoint on the existing variable n in feed. We could
select a watchpoint by clicking on it to enable, disable or delete it.

Step 52. To close the List Watchpoints window, click on Cancel.

Step 53. If you want to trace the value of the variable as the thread runs you can make
the debugger do an automatic Print and Continue every time the watchpoint
occurs by typing a suitable command in the command window.

Move the cursor to the command window at the bottom of the debug screen
and click the left mouse button to make the window active.

Step 54. Type in the following command, followed by a carriage return:

when (6) (w=step; wait(w); fid=2; write n is (print n); continue}

This tells the debugger to wait until event 6 occurs and then

step one more instruction to update the variable n,

wait for the step to complete,

• select frame 2,

• output the text 'n is' together with the value of n, and then

continue execution.

You may remember that event 6 is the watchpoint you set a moment ago. The
watchpoint occurs before the variable is changed, so we step past the assign­
ment so that the value of n printed will be the new one.

Step 55. If you are using a Sun, then the output window is only one line deep. You can
change the height of this window so that you can see a history of the most
recent messages. You do this by dragging the sizing box.

Move the cursor to the output window sizing box, which is the small box at the
top of the scroll bar, as shown in figure 5.20. Notice that the cursor changes
to a cross when it is on the box. Click and hold the mouse button down whilst
you drag the box up the screen. Keep dragging until you have an output
window four lines deep.

Figure 5.20 The Sun output window before re-sizing
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5 An example occam interactive debugging session

Figure 5.21 The enlarged Sun output window

Step 56. Click on the Continue button.

Step 57. Type in another number at the prompt 'Please type n : '. The new value
of n is displayed in the output window and the thread continues execution.
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5.3.16 Deleting a watchpoint

Step 58. You can now delete the watchpoint you set on n.

To set a watchpoint we selected a variable. To delete the watchpoint we select
the declaration line. Select line 18 of feed.occ by clicking on it. This line is
the declaration of n, which has the watchpoint symbol on it, <3 on Suns or (I
on pes.

Figure 5.22 Line 18 with watchpoint set

Step 59. With the declaration line selected, click on the Delete button to remove the
watchpoint. The watchpoint symbol disappears

Step 60. Type in another number at the prompt 'Please type n :'.

Notice that the program now executes normally since the watchpoint has been
removed.
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5.3.17 Jumping down a channel

To explore the wider context of a thread we may wish to look at the threads that
communicate with it. To find a thread that is waiting for a communication, we can jump
down a channel. This means that we are changing context to the thread that is waiting
for communication on that channel.

At most one thread can ever be waiting for one channel; when two threads are ready
then communication starts. If no thread is waiting then the Jump operation will not
change the context. If the current thread is waiting then, again, the Jump operation will
not change the context.

Step 61. Thread feed has a channel output statement at line 23. You are now going to
use this statement to jump to the thread that is waiting on the channel. First you
must interrupt execution of thread 2.

Step 62. Stop the feed thread by clicking on the Interrupt button. Enter another value
for n so that the program runs on to the interrupt. Then Step so that the thread
comes out of the VIRTUAL. IN routine to code that has full debugging.

Step 63. Move the cursor to line 23 and select the channel name 'aut' by double clicking
on it.

Step 64. Jump to the thread waiting on this channel by clicking on the Jump button.
Notice that the source code for facs is now displayed in the code window with
the current line marker resting on the input statement to read from the channel
from. feed, which is the other end of the out channel in feed.

5.3.18 Leaving the debugger

Step 65. You have now finished the example interactive debugging session. If you want
to exit from the debugger, click on the File menu and select the Exit or Quit
option. A pop-up dialog box will appear asking you to confirm the exit request.
Select Yes and the debugger will close its windows and exit.

On PC systems, you may wish to also close the ISERV window.

This concludes the tutorial for interactive debugging with occam programs.
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6 An example occam post-mortem
debugging session

This chapter takes you in detail, step by step, through one example post-mortem
debugging session, to demonstrate the basic features that are available for post­
mortem debugging. This chapter uses an occam program as the example. A similar
ANSI C example is described in chapter 3. In particular this chapter shows you how to:

build the program for post-mortem debugging;

• start the debugger when the program fails;

locate where the crash has occurred and the reason for it;

examine a variable;

examine a call stack;

• jump down a channel;

quit from the debugger.

Before starting the session you need to know a little about the example program. This
is the same program as is used in chapter 5, so if you have not worked through the
interactive debugging session, read section 5.1 before proceeding.

Before starting the tutorial you may find it useful to have a listing of the example program
source code. It would also be useful to look at figure 2.1 or figure 2.2 in section 2.4 to
show you the names of the parts of the debugger display.

6.1 Post-mortem debugging

Post-mortem debugging means debugging after the program has crashed, terminated
or been stopped. It may have crashed during normal running or during an interactive
debugging session. In this tutorial, we shall start from normal- execution. Starting from
an interactive session is easier and is described in section 2.4 of chapter 2 in the
INQUEST User and Reference Manua/.

During post-mortem debugging you can navigate through the code and explore the
state of the program exactly as in interactive debugging. However, the program cannot
be restarted, so stepping, interrupts, breakpoints and watchpoints do not apply. The
debugger just allows you to inspect the state of the program when it was halted.

6.1.1 Building the code

Post-mortem debugging only requires that the code has been compiled with full debug­
ging data, Le. without the D option.
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6.1 Post-mortem debugging

On Sun systems, the example program makefile builds the example application for you
and is called makefile. On a PC, a batch file called build.bat is provided to do this.
This generates a bootable file for post-mortem debugging called app~m.btl.

The contents of the configuration file are shown in figure 3.2.

For the purposes of this tutorial, all the processes are configured to run on the same
processor.

6.1.2 Starting post-mortem debugging

When a program crashes during normal execution then the host is returned to the state
before the program was run. Post-mortem debugging can then be started by the
inquest command.

On a PC this can be done from the File Manager by double clicking on the
inquest. exe program, which makes a command line box pop up. The browse button
is used to select the application app-pm.btl. The -pm option is added in the Options
box to request post-mortem debugging.

On a Sun this is done by typing the inquest command at the operating system prompt
with the -pm option to request post-mortem debugging:

inquest app~m.btl -pm

The debugger will analyze the transputer network. This means that signals will be sent
to the network to halt any threads that may be still running, and then the network will be
reset without losing any state information. After analyzing the network, the debugger
uses a network mapper to explore the state of the network. The debugging display will
appear on the screen.

If the transputer error flag was set, then a message will appear showing where the error
occurred. The source line where the error happened is automatically located by the
debugger. The process causing the error can then be explored and other processes
located using Jump.
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6.2 Step-by-step tutorial

Here is a step-by-step tutorial to guide you through the main features of INQUEST
post-mortem debugging.

Step 1. Move to the app_occ sub-directory in the examples directory which contains
the occam example program app. Run the set-up script to set up the environ­
ment, as follows.

On Sun systems, at a prompt type:

source setup.csh

or

• setup.sh

On PC systems, at a DOS prompt type:

setinq

Step 2. Check that the TRANSPUTER parameter is correctly defined.

Step 3. The root transputer must be an IMS T400, IMS T42S, IMS T801, IMS TaOS,
ST20 (T4S0) or IMS T9000. The example is configured for a single ST20 orfor
a single IMS T9000 depending on the INQUEST version.

If you are using a different type of root transputer then you will need to edit:

a the hardware configuration file, hardocc;

a for Suns the make macro file tools or for PCs the build batch file
build.bat.

The changes to make in each case are given in table 6.1.

Target All users: Sun users only: PC users only:
file hardocc file tools file build.bat

ST20/T4S0 No change No change No change

IMS T9000 No change No change No change

IMS T400 or T42S Change T450 to T42 5 Change 450 to 425 Change t450 to t425

IMS T801 or T80S Change T450 to T805 Change 450 to 80S Change t450 to t805

Table 6.1 Changes to examples to support different targets

Step 4. Create a bootable file, suitable for debugging. To do this on a Sun, at an
operating system prompt type:

make

On a PC, type:

build
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6.2.1 Starting the debugger

Step 5. Run the example program, app-pm.btl, which is the bootable code for
post-mortem debugging you created in Step 4.

On PC systems, start up Windows, open the File Manager and double click on
the inquest. exe program. This will open the Command line dialog box. Use
the browse button next to the File field to find and select the application
app-pm.btl in the app_occ sub-directory in the examples directory. Click
on the Run button in the Command line box.

Since the code has not been configured for debugging, this loads the applica­
tion for normal execution onto the target hardware. The parameters you can
give to irun are described fully in the irun chapter of your Toolset Reference
Manual.

On Sun systems type:

irun app-pm.btl

Since the code has not been configured for debugging, this loads the program
for normal execution onto the transputer.

The parameters you can give to irun are described fully in your host interface
software or network interface software user manual.

Step 6. The program will ask for a number with the prompt:

Sum of the first n (n < 9) squares of factorials
Please type n :

Enter the number 10 to make the arithmetic overflow and the program crash.
The host server detects the error flag and displays these messages:

Transputer error flag set

Error - iserv - Transputer error flag set

Step 7. On PC systems, in the File Manager, double click on the inquest.exe
program. This will open the Command line box again. Use the browse button
again next to the File field to find and select the application app-pm.btl in
the app_occ sub-directory in the examples directory. This time type -pm in
the Options field to tell INQUEST to do a post-mortem debug. Click on the Run
button in the Command line box.
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1§o.I Inquest ljiffik
Eile Execution Events ~ariables .options Window Help

.#iI Program: APP_PM.BTL 1*1+
C:\INQUEST\EXAMPLES\APP_OCC\app.pgm

1 !lINCLUDE "hardocc·
2 iINCLUDE ·hostio. inc·
3 iINCLUDE ·pipe. inc·
4
5 !lUSE ·control. lku·
6 !lUSE ·feed.lku·
7 !lUSE· facs .lku·
B C!I !I~E ·square.lku·
9 l!USE ·sum.lku·

10

1##\ I
I~~~~~~~I

". .... :;",,/;;:,:,::::tv:,,;,""""":,,;;;;,' ::::,:'i'i:""'" ::,:i;;;;;"''''''''':j;j ..":"...~,~" .. ,,..

§I Inquest - Browser Inquest - Cmdline

I'SEARCH: c:\inquest\libs\;c:\occam\libs

1 1 RootNodeJ) main: Error Flag set at <square,ace 22 0>

00>

Figure 6.1 The Microsoft Windows start-up display for the example program

On Sun systems, start the post-mortem debugger with the command:

inquest app-pm.btl -pm

Step 8. Wait while a debugging display is created. The debugger has explored the
network and is showing the state of the program when it was stopped.
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Figure 6.2 The X-Windows initial display for the example program

Step 9. To show where the program set the error, click on the Last Event operation
button. Figure 6.2 shows the X-Windows display; the PC display is shown in
figure 6.1 . Source code is shown in the code window with the next statement
marker, [2l on Suns or l> on PCs, next to the line that crashed, which should
be the line:

square := n * n

If the program had not crashed, it could have been halted by pressing
Control-C. Control-C only stops the host server, so the transputer program will
generally be waiting at the next point where it interacts with the host. Running
the post-mortem debugger will kill the program.
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6.2.2 Examining a variable

Step 10. You are now going to examine the value of a variable.

Click twice on the variable 'n' on line 17,20 or 22 to select it. Clicking twice
selects the whole of the word where the cursor is.

Step 11. Display the value of the variable by clicking on the Print button. The Print
button displays the value in the output window; it does not produce a hard copy.

The output window should now display the simple message:

362880

This tells you that n has the value 362880, and the error flag was set because
the square of this number is too big to fit in a 32-bit integer.
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6.2.3 Examining the call stack

Step 12. You can find out which line has called the factorial function by examining
the call stack. You do this using the browser window to go to frame level.

Normally you would move the cursor to the browser window and click on the
Call Stack button, but the debugger has automatically started at frame level,
so there is no need to do this. At frame level the browser window displays the
call stack, which is a list of function and procedure calls, with the most recent
call at the top, as in figure 6.3.

Figure 6.3 Call stack for the initial display

The top line shows that in this thread the function square has halted at line
22 in the source code file square. occ. The line below shows that square
was called by main at line 23 of the file app. pgm. The asterisk (*) means that
main started the thread.

Step 13. You can display the source code of any of the frames to see where the call was
made to the next frame up the stack.

Move the cursor to the browser window and click on 'l*main() at
<app.pgm 23 0>'. In the browser window, the selected frame is highlighted,
as in figure 6.4. The code window has changed to display line 23 of the
configuration code, with the call of square marked as the current line with the
next statement marker, [2] on Suns or P> on PCs, as in figure 6.5.

Figure 6.4 Frame main () selected
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Figure 6.5 Frame main () code

Moving up and down the stack, examining the variables at each level, gives
you a clear view of what happened to the thread just before it crashed.
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6.2.4 Using the browser

Step 14. We can look at other threads by using the browser. Move to the top, or
program, level by clicking on the Processes button in the browser window. Tell
the debugger to search for the threads of the program by pulling down the
Execution menu and clicking on Find Threads.

The browser shows a list of one process, RootNode-p. Select the process
RootNode-p by clicking on it. This moves the display to process level, with the
browser window showing a list of threads in the process with their states, as
shown in figure 6.6.

Figure 6.6 Process level browser display

The first thread, shown as RootNode-p main, is square, which set the error
flag. The other listed thread, shown as RootNode-p main [1], is facs,
which is waiting for processor time. The other threads are all waiting for chan­
nels, so the debugger cannot find them except by jumping down the channels.

Step 15. To move to the facs thread, double click on 'RootNode-p main[l]:
scheduled'. The display changes to the frame level display, as shown in
figure 6.7. The selected thread is highlighted and the code window shows the
source code for the facs thread, with the next statement marker ([2] on Suns
ort> on pes) on the line that was waiting to complete, as shown in figure 6.8.

Figure 6.7 Frame level browser display

Figure 6.8 The facs thread
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6.2.5 Jumping down a channel

When the square thread crashed, the transputer halted, leaving the other threads
queued or waiting for channels or timers. If there were more transputers in the network
then they would continue running until they were all waiting for communications with the
crashed transputer or they were analyzed by INQUEST.

To explore the wider context of the crashed thread we may wish to look at the threads
that communicate with the crashed thread. To find a thread that is waiting for a commu­
nication, we can jump down a channel. This means that we are changing the context
to the thread that is waiting for communication on that channel.

At most one thread can ever be waiting for one channel; when two threads are ready
then communication starts. If no thread is waiting then the Jump operation will not
change the context.

Step 16. Select the channel to. square by clicking twice on a reference to it. Click on
the Jump operation button to jump down the to. square channel. The
to. square channel is empty, i.e. no thread is waiting for it, so nothing
happens, except that the message

*empty*

appears in the output window.

Step 17. Select the channel from. feed by clicking twice on it. Click on the Jump
operation button to jump down the out channel. The context will change to the
feed thread, which is waiting to send on this channel. The channel is called
out within the feed procedure. The next statement marker shows exactly
which statement is waiting to send.
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6.2.6 Leaving the debugger

Step 18. You have now finished the example post-mortem debugging session. If you
want to exit from the debugger, click on the File menu and select the Exit or
Quit option. A pop-up dialog box will appear asking you to confirm the exit
request. Select Yes and the debugger will close its windows and exit.

This concludes the occam tutorial on post-mortem debugging.
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thread, 5-7

Line markers, 9

Locate operation, 10

M
Markers in code window, 9

Menu, bar, 8

N
Next operation, 9

Next statement marker, 9

o
Operations

Break, 10
Continue, 9
Delete, 10
Interrupt, 9
Jump, 10



Index

Last Event, 10
Locate, 10
Next, 9
Print, 10
Print *,10
Step, 9
Step Out, 9
Step To, 10
Watch, 10

Operations buttons, 9-10

Output window, 10

p

Post-mortem debugging, 73-84

Post-mortem debugging, 35-36

Preparing code, for debugging, 14-34, 35-36,
47-72,73-84

Print * operation, 10

Print operation, 10

Process, 4
level of browser, 5

Program level of browser, 4-5

s
Selected line marker, 9

Single step, 24-34, 58-72

Stack, trace, 25-34, 41-43, 59-72, 80-81

Start-up, debugger, 16-23, 36-44, 50-72,
74-84

Step operation, 9

Step Out operation, 9

Step To operation, 10

Stepping, 24, 26-34, 58, 60-61

T
Thread, 4

level of browser, 5-7

v
Variables, displaying the value, 23-34, 42-43,

57-72, 79

w
Watch operation, 10

Watchpoints
deleting, 33-34, 70-72
line marker, 9
setting, 31-34,67-72

Window, debugging, 7-10
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